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TIN HỌC B VĂN PHÒNG    
 

Word , Excel, PowerPoint, Internet 

GV: Nguyễn Quang Vinh 

Website: www.nguyenquangvinh.net 

Email: info@nguyenquangvinh.net 

Yahoo: Vinh_DJ008 

Facebook.com/nguyenquangvinh.n 
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MỤC TIÊU 

Tin học B văn phòng 

 

-   Sử dụng thành thạo các kỷ năng nâng cao 

trong soạn thảo, xử lý và in ấn văn bản. 

-   Nắm vững các kỹ thuật xử lý nâng cao trên 

Excel 

-   Tạo hiệu ứng trình diễn hình ảnh, âm thanh 

và phim minh họa trong PowerPoint 

-   Khai thác thông tin trên Internet, bảo mật và 

phòng chóng virut. 
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Nội dung 

Tin học B văn phòng 

 
Word NC 

 
 
 
 

PowerPoint B VP Excel NC 

 
 
 
 

Internet 
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MS WORD NÂNG CAO 

 
Giới thiệu: 

 
I.    Các thao tác với Form 

II.   Định dạng văn bản nâng cao 

III.  Trộn tài liệu Mailing 

IV. Import và Macro 
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MS WORD NÂNG CAO 
 

I.    Các thao tác với Form 

1.1. Tạo Form mẫu 

B1:Tạo biểu mẫu bằng văn bản theo yêu cầu 

B2: Vào Developer 
 

 
 
 

B3: Chọn Legacy Tools 
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MS WORD NÂNG CAO 
I.    Các thao tác với Form 

1.1. Tạo Form mẫu 

B4:Mục Legacy Forms: chọn dạng cần tạo    

-   Text Form Field: cho phép nhập chữ, số, 

tính toán … 

-   Check box Form Field: tạo ô chọn hoặc 

không chọn. 

-   Drop-down Form Field: tao dạng danh sách 

dữ liệu. 

-   Form Field Shading: Chọn màu nền cho các 

vùng dạng form 
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MS WORD NÂNG CAO 

I.    Các thao tác với Form 

1.1. Tạo Form mẫu 

B4: Mục Legacy Forms: 

Để định dạng cho vùng dữ liệu: 

-   Cách 1: double click vào vùng dữ liệu 

 
-   Cách 2: Click chuột vào vùng dữ liệu chọn    

thẻ Developer / Properties 

 
-   Cách 3: Click chuột phải vào vùng dữ liệu 

chọn Properties 
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MS WORD NÂNG CAO 
I.    Các thao tác với Form 

1.1. Tạo Form mẫu 

B4: Mục Legacy Forms: 

1.1.1.Text form field Option 

+ Type: kiểu dữ liệu nhập 

o Regular text: nhập chữ 

o Number: nhập số 

o Date: ngày tháng 

o Calculation: tính toán 

o Current date: ngày tháng hiện tại 

o Cureent time: giờ hiện tại 
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MS WORD NÂNG CAO 
 

1.1. Tạo Form mẫu 

B4: Mục Legacy Forms: 

1.1.1. Text form field Option 

+ Default text: giá trị hiển thị mặt định    

+ Maximum length : giới hạn nhập 

+ Bookmark: đặt tên cho ô dữ liệu 

+ Calculate on exit: tự động tính toán khi 

nhập xong 
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MS WORD NÂNG CAO 

I.    Các thao tác với Form 

1.1. Tạo Form mẫu 

B4: Mục Legacy Forms: 

1.1.1. Text form field Option 

+Text fomat: các kiểu định dạng 

o Uppercase: chữ hoa 

o Lowercase: chữ thường 

o First Capital: viết hoa đầu câu 

o Tile case: viết hoa chữ cái đầu tiên    

o #,##0: phân cách hàng ngàn 

o #,##0 vnd;(#,##0 vnd): đơn vị tiền tệ    

o 0%: định dạng % 
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MS WORD NÂNG CAO 
I.    Các thao tác với Form 

1.1. Tạo Form mẫu 

B4: Mục Legacy Forms: 

1.1.2. Drop-down Form Field: tao dạng danh 

sách dữ liệu. 

VD: Tạo cột ô tên hãng chọn trong danh sách: 

Samsung, Sony, Dell… 

+ Drop-down item: nhập dữ liệu 

+ Click Add>> để thêm vào list 

+ Click Remove để xóa 

+ Ok 
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MS WORD NÂNG CAO 
I.    Các thao tác với Form 

1.1. Tạo Form mẫu 

B5: Bảo vệ Form 

- Developer/ Protect Document/ Restrict 

Formatting and Editing 

-   Tại cửa sổ Restrict Formatting and Editing 

Đánh dấu check vào ô Allow only this type of    

editing in the document -> Chon Filling in form 

. Sau đó chọn Yes, start Enforcing Protection.    

-   Nhập pass vào ô theo yêu cầu (nhập 2 lần 

giống nhau) 

-   OK 
12 



 

Page 5 of 14 

GV: Nguyễn Quang Vinh–Email: info@nguyenquangvinh.net–Website: www.NguyenQuangVinh.Net 

 
1.3. 

 
Tính toán trong Table 

 
1.3. T 

 
ính toán trong Table 

 
 

 
 

 
 

 
  

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
  

 
 

 
 

 

A1 B1 C1 D1 

A2 B2 C2 D2 

A3 B3 C3 D3 

 

I.    Các thao tác với Form 

1.2. Tính toán trong Form 

Tạo text form field cho ô thực hiện phép tính 

-   Type: Calculation (cho phép nhập công thức 

tính toán) 

-   Expression: nhập công thức cần tính bắt đầu 

bởi dấu = 

-   Check  Calculate on exit 

VD: ô số lượng tên là: sl , ô đơn giá tên là: dg 

Tại ô thành tiền sẽ nhập như sau: = sl*dg 

Có thể sử dụng các hàm để tính toán như : IF, 

AND, OR, SUM, COUNT … 
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MS WORD NÂNG CAO 
I.    Các thao tác với Form 

 
Layout/ Data/ Formula 

-   Fomula: nhâp công thức tính 

•   Abs, Sum, Avegare,Count 

•   Min, Max,… 

-   VD: Avegare (C2:E2) 

-   Sum(Left) : tính tổng các ô bên trái Above: bên 

trên, Right: bên phải, Below:phía dưới 

-   Tính nhanh cho nhiều ô cùng công thức: copy 

công thức cho các ô giống nhau -> bôi đen F9 

chỉ áp dụng khi dùng với left, right, above, below 
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MS WORD NÂNG CAO 
I.    Các thao tác với Form 

 
+ Chú ý: vị trí các ô trong bảng  mặt định được đặc 

tên theo hàng và cột tương tự excel. Có thể dùng địa 

chỉ ô có sẵn để tính toán. 

 
VD: 

 

 
 
 

Tính tổng các số từ A1 đến C1: Sum(A1:D1) 

 
Minh họa 15 

Minhhoa.xlsx
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II.   Địn 
 

2.1. Định dạng văn bản dùng Style 

B1: Click chuột phải tại đoạn văn bản cần định 

dạng /chọn styles / Select text with similar 

Formatting (chọn các phần văn bản cùng màu) 

- Trường hợp chỉ có 1 màu đen thì Ctrl+click 

chọn các dòng cần định dạng. 

B2: Click chuột phải tại đoạn văn bản cần định 

dạng /chọn styles /Save selection as a New 

Quick style -> đặt tên styles (vd: mau1, mau2) 
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MS WORD NÂNG CAO 
II.   Định dạng văn bản 

 

2.1. Định dạng văn bản với Style 

B4: Tiến hành định dạng cho từng style theo 

yêu cầu. 

-   Đóng khung, tô màu, canh lề… 

-   Đánh số thứ tự theo cấp đề mục tự động thay 

đổi 

VD: I.Tiêu đề 

1.1. tiêu đề 

a. tiêu đề 
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MS WORD NÂNG CAO 
II.   Định dạng văn bản 

mục 

Home/ Multilevel List-> Define New Multilevel 

list 

- Chọn cấp tương 

ứng với Style đã 

tạo(cấp 1-> mau1,…) 

- Enter formating … 

định dạng cho số 

- Number style for level 

kiểu đánh số 

- Include level …:   thêm 1 số trước số hiện tại (1.1) 

- Legal style numbering: chỉ đánh kiểu số 18 
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II.   Định dạng văn bản 

2.2. Tạo mục lục tự động 

2.2.1 Mục lục cho văn bản thường 

B1: View/ Outline 

Click chuột vào từng đề mục bên dưới văn bản 

rồi chọn level tương ứng từ cao đến thấp (chọn 

level ở tab menu Outlining, level 1, level 2, …) VD 

: I. -> level 1 

1.1 -> level 2 

II. -> level 1 

2.1 -> level 2 

a. -> level 3 
19 

 

 
 
 
 
 
 

MS WORD NÂNG CAO 
II.   Định dạng văn bản 

 

2.2. Tạo mục lục tự động 

2.2.1 Mục lục cho văn bản thường 

B2: Nhấn Close Outline view để thoát ra khỏi 

chế độ tạo level quay về màn hình bình thường 

 
B3: Đặt trỏ chuột tại nơi muốn chèn mục lục: 

-> menu References/Table of Contents/Insert 

table of contents. 
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MS WORD NÂNG CAO 
II.   Định dạng văn bản 

 

2.2. Tạo mục lục tự động 

2.2.1 Mục lục cho văn bản thường 

B3:Chỉnh các thông số 

-   Show page numbers : hiện số trang 

-   Right align page number: số trang nằm bên 

phải 

-   Tab leader: kiểu đường liên kết giữa tiêu đề và 

số trang 

-   Show level: số cấp level đề mục cần hiển thị 

-   Use hyperlinks..: liên kế đến nội dung. OK 
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II.   Định dạng văn bản 
 

2.2. Tạo mục lục tự động 

2.2.2 Mục lục văn bản theo định dạng style 

B1: menu References/Table of Contents/Insert 

table of contents. 

B2: Chọn Options / tại phần TOC level xóa hết các 

số của heading, Tìm đến  phần tên style đã định 

dạng chọn cấp hiển thị từ 1->2->3… cho các style 

cần làm mục lục. ->OK 

VD: tạo mục lục cho mau2, mau3 

mau2 = 1, mau3 = 2 
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MS WORD NÂNG CAO 
II.   Định dạng văn bản 

 

2.2. Tạo mục lục tự động 

- Cập nhật lại mục lục: References/ Update table 

+ Update page number only: cập nhật số trang 

+ Update entire table: cập lai toàn mục lục 

-  Bỏ số trang và Leader mục lục: Alt+F9 

{Toc “ ….”    \n “1-1”} (1-1 bỏ Cấp 1, 1-2 bỏ cấp(1,2) 

-> Aft + F9 ->Update mục lục:Update entire table 

- Leader mục lục khác nhau: sửa tab của leader 

cần đổi -> Update entire table 
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MS WORD NÂNG CAO 
II.   Định dạng văn bản 

 

2.3. Header, Footer 

- Tạo Header/ Footer 

Insert-> Header/ Footer 

Hoặc double click vào phần đầu, cuối trang giấy 

 
- Sửa Header/ Footer 

Double click trực tiếp vào ngay header/footer 
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II.   Định dạng văn bản 
 

2.3. Header, Footer 

2.3.1. Đánh số trang cho văn bản 

B1: header hoặc footer 

B2: vào thẻ Design / Page Number 

-   Current Position: đánh số trang  tại vị trí đặt 

con trỏ chuột. 

-   Current Position->Page X of Y: số trang/tổng 
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MS WORD NÂNG CAO 
II.   Định dạng văn bản 

 

2.3. Header, Footer 

2.3.2.Định dạng trang chẵn , lẻ khác nhau 

B1: Vào Header/footer của trang lẻ vào thẻ 

Design/click chọn Different Odd & Even Page 

 
B2: Định dạng Header/Footer cho trang lẻ 

 
B3: Định dạng Header/Footer cho trang chẵn 
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MS WORD NÂNG CAO 
II.   Định dạng văn bản 

 

2.3. Header, Footer 

2.3.3.Header/ Footer từng trang khác nhau 

B1: Ngắt trang cần định dạng khác :Page Layout 

-> Breaks ->Next page 

B2: Vào Header/footer của trang vừa ngắt: 

Design -> bỏ Link to Previous 

B3: Đánh lại tiêu đề cho trang, 

- Đánh lại số trang: Page number -> Format 

page number -> start at 
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II.   Định dạng văn bản 
 

2.3. Header, Footer 

2.3.4. Định dạng trang ngang bất kỳ 

B1: Ngắt trang cần định dạng: Page Layout -> 

Breaks ->Next page 

B2: Đặt con trỏ tại trang cần định dạng nằm 

ngang -> Page Playout -> Orientation -> 

- Landscape (trang ngang) 

- Portrait (trang đứng) 
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MS WORD NÂNG CAO 
II.   Định dạng văn bản 

 
2.4. Watermark 

B1: Page Playout / Watermark -> Custom 

watermark 

-   Picture watermark: dùng hình làm nền 

-   Text watermark: dùng chữ làm nền 

B2: Chỉnh sữa watermark: 

- Click vào header/footer 

-> Click chọn phần watermark cần chỉnh sữa. 

Double click chuột ra vùng trắng để hoàn thành 
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MS WORD NÂNG CAO 
II.   Định dạng văn bản 

2.5. Biểu đồ, lưu đồ 

2.5.1. Biểu đồ: 

B1: Insert/ Chart -> chọn loại biểu đồ cần vẽ 

B2: Nhập thông số cần vẽ vào bảng excel cho sẵn. 

Nhập xong thoát khỏi excel. 

B3: Điều chỉnh hình dạng biểu đồ: click vào cột 

cần định dạng -> Format/ Format Selection 

-   Shape: kiểu hình 

-   Fill: nền 

-   Border color: màu viền , Border style: kiều viền 

-   Shadow: tạo bóng , 3-D Format: tạo 3D 
30 
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II.   Định dạng văn bản 
 

2.5. Biểu đồ, lưu đồ 

2.5.2. Lưu đồ: 

B1: Insert/ SmartArt -> chọn dạng lưu đồ cần 

vẽ. 

B2: Định dạng : Right Click lên hình bất kỳ 

trong lưu đồ 

-   Add shape (thêm 1 hình), 

-   Change Shape (thay đổi hình khác) 

-   Format shape (định dạng liên quan màu sắc) 
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MS WORD NÂNG CAO 
II.   Định dạng văn bản 

 

2.6. Find & Replace ( Tìm kiếm và thay thế) 

B1: Home/ Replace -> Xuất hiện bảng Find & 

Replace 

-   Find what: từ cần tìm 

-   Find replace: từ thay thế 

Click More để hiện cửa sổ định dạng -> Format 

chọn các kiểu định dạng cho văn bản. 

B2: Nhấp Replace để thay đổi từng đối tượng 

hoặc Replace all thay đổi tất cả. 
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MS WORD NÂNG CAO 
II.   Định dạng văn bản 

 

2.7. Note ( tạo ghi chú cho văn bản) 

- Tạo ghi chú: 

B1: Bôi đen những chữ cần tạo ghi chú. 

B2: Menu Reference/ Insert Footnote 

Nhập phần ghi chú cần tạo 

-Xóa: 

Bôi đen số ghi chú -> delete 
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Họ tên Ngày sinh Điểm 
Nguyễn Văn A 01/01/1980 8 
Trần Thị B 01/01/1970 10 

 

III.  Maillings 
 

Mailling là công cụ giúp người dùng có thể trộn 1 danh sách 

vào mẫu có sẵn, đặc biệt có khả năng trích lọc theo điều kiện. 

Các loại Maillings thường dùng: 

-    Letter: các dạng thư 

-    Envelopes: tạo bì thư 

-    Label: tạo nhãn 

-    Directory: liệt kê theo dạng danh sách. 

Để có thể thực hiện trộn thư ta phải có 1 danh sách cho trước 

phải là dạng Word bảng hoặc excel. 

VD: 
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MS WORD NÂNG CAO 
III.  Maillings 

 

3.1. Letter 

Maillings/ Start Mail Merge -> Step by Step Mail Merge 

- Step 1 of 6 :chọn Letters - > Next Starting document 

-  Step 2 of 6 : Next Select recipients 

-  Step 3 of 6 : Browse tìm đến file chứa danh sách 

Filter : Lọc dữ liệu 

-  Step 4 of 6 : Chèn dữ liệu : More item -> insert tên cột 

-  Step 5 of 6 : Kiểm tra kết quả: << >> 

-  Step 6 of 6 : 

Edit Individual Document : in ra trang word 

Print document : in truc tiếp ra máy 
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MS WORD NÂNG CAO 

III.  Maillings 

 
3.2. Envelopes 

Maillings/ Start Mail Merge -> Step by Step Mail Merge 

- Step 1 of 6 :chọn Envelopes - > Next 

-  Step 2 of 6 : Envelopes Option -> chọn size 

-  Step 3 of 6 : Browse tìm đến file chứa danh sách 

Filter : Lọc dữ liệu 

-  Step 4 of 6 : Chèn dữ liệu : More item -> insert tên cột 

-  Step 5 of 6 : Kiểm tra kết quả: << >> 

-  Step 6 of 6 : 

Edit Individual Document : in ra trang word 

Print document : in truc tiếp ra máy 
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III.  Maillings 

 
3.3. Labels 

Maillings/ Start Mail Merge -> Step by Step Mail Merge 

- Step 1 of 6 :chọn Labels - > Next 

-  Step 2 of 6 : Label Option -> New label 

Tạo mới và hiệu chỉnh kích thước cho các nhãn 

-  Step 3 of 6 : Browse tìm đến file chứa danh sách 

Filter : Lọc dữ liệu 

-  Step 4 of 6 : Chèn dữ liệu : More item -> insert tên cột 

Chỉ chèn cho nhãn đầu tiên -> Update All 

-  Step 5 of 6 : Kiểm tra kết quả: << >> 

-  Step 6 of 6 : 

Edit Individual Document : in ra trang word 

Print document : in truc tiếp ra máy 

 

 
 
 
 
 
 

MS WORD NÂNG CAO 

III.  Maillings 

 
3.4. Directory 

Maillings/ Start Mail Merge -> Step by Step Mail Merge 

- Step 1 of 6 :chọn Directory - > Next 

-  Step 2 of 6 : Next Select … 

-  Step 3 of 6 : Browse tìm đến file chứa danh sách 

Filter : Lọc dữ liệu 

-  Step 4 of 6 : Chèn dữ liệu : More item -> insert tên cột 

Trường hợp trộn dạng danh sách thì chỉ tạo bảng 1 dòng duy 

nhất sau khi trộn xong mới tiến hành thêm tiêu đề. 

-  Step 5 of 6 : Kiểm tra kết quả: << >> 

-  Step 6 of 6 : New Document : trộn sang trang word    
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MS WORD NÂNG CAO 

III.  Maillings 
 

3.5. Cách sử dụng IF trong Mail Merge 
 

Để hiển thị các thông tin dựa vào nguồn dữ liệu cho trước 

VD: Nếu giới tính là Nam thì thêm chữ Thầy trước Tên    

ngược lại thêm chữ Cô 

B1: Đặt con trỏ tại vị trí cần sử dụng IF vào Menu 

Maillings / Rules -> IF … Then … Else 
 

 
 
 
 
 

39 



 

Page 14 of 14 

GV: Nguyễn Quang Vinh–Email: info@nguyenquangvinh.net–Website: www.NguyenQuangVinh.Net 

 
 

 
 

 
 

 
  

 
 

 
 

 

 
 

 
 

 
 

 
  

 
 

 
 

 

41 

IV. Import và Macro 
 

3.6. Kết xuất dữ liệu ( Import) Excel->Word 

 
-    Insert -> Quick Parts -> Field -> Field names: 

Database -> Insert Database -> Get Data ( tìm đến    

file cần lấy dữ liệu) 

-    Query Options : 

Filter: Lọc , Sort: Sắp xếp, Select fields: chọn cột hiển thị 

-    Insert Data: chèn dữ liệu vào bài 
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MS WORD NÂNG CAO 
IV. Import và Macro 

 

4.1. Tạo Macro 

B1: Tạo Macro 

View -> Macro -> Record Macro 

-   Đặt tên macro, gán phìm tắt … 

-   Tiến hành làm thao tác cần lưu 

-   View -> Macro -> Stop Recording 

B2: Chạy Macro: View -> Macro->View 

Macro -> Chọn tên -> Run 

B3: Đính kèm Macro: Save As 

type: Chọn Word Macro-Enabled Document 

(*.docm) 


